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Using the Account Center in the Web Portal
_____________________________________________________________________________________
Introduction
_____________________________________________________________________________________
This video tutorial discusses how to use the Account Center in the eFolder Web Portal. This is an advanced training video that covers the Account Center in detail. Before watching this video, you should have viewed the related video in this series entitled, Overview of the Web Portal.
As you recall from the overview video, the Web Portal provides two alternative interfaces for viewing and managing your accounts—the Account Center and the Account List. Both of these options provide roughly the same functionality, but they have different user interfaces. The Account Center is an interactive, point-and-click, intuitive-type interface. The Account List provides a very detailed report-like interface with embedded commands and links. Some partners prefer one over the other or use one for some tasks and the other for other tasks. In general, the Account Center is easier to use, but requires a few additional clicks to view all of the account information. The Account List shows all of the relevant account information, but it can be overwhelming except for power users, and it requires some horizontal scrolling to see all the fields. This video will show you how to use the easier-to-use Account Center interface.
_____________________________________________________________________________________
A quick overview of the Account Center page
_____________________________________________________________________________________
Access the Account Center by opening the Web Portal and selecting Account Center (Visual View) in the Accounts menu option.
The Account Center is organized into four main areas. The first area is the menu bar at the top. Use the options displayed here to create new accounts, manage existing accounts, change the appearance of information displayed in the account list, change which related groups of fields are displayed in the account list, view detailed information for an account, and enter search parameters and filters to display the accounts you want to view or manage.
The next major area in the Account Center is the list of accounts, either those that match the search criteria you entered in the search and filter box above, or all of the accounts that you are authorized to see. This list is presented in tabular format, with each account listed on a separate row. The columns in this list display the fields and information that are associated with each account, with the field names and information icons at the top.
The third area is the navigation control area at the bottom of the screen. Use the fields and buttons in this area to page through the account list when the list is too long to display on a single page, to navigate to a specific page in the listing, to refresh the page with the latest information, and to select how many accounts to display per page.
The final main area of the Account Center is the Account Details Information panel. This area can be toggled on and off by clicking the Account Details icon in the menu bar, by double-clicking on an account in the account list, or by right-clicking on an account and selecting Show/Hide Details. This area displays detailed information for the currently selected account.
_____________________________________________________________________________________
The New and Actions menu bar options
_____________________________________________________________________________________
To begin, let’s take a closer look at each of the options and buttons on the Account Center menu bar. The first option is the New option, which you can use to create new accounts. Select New on the menu bar to launch the New Account Wizard, which is a more user-friendly way to create a new account or customer than manually entering data on the Create Account page that is accessed from the Accounts main menu bar of the Web Portal. How to use the New Account Wizard is explained in the related training video in this series entitled, “Overview of the Web Portal,” which you should have already viewed.
Select Actions on the menu bar to perform an action on the currently selected account in the account list. The currently selected account appears with a darker background and has a check mark in the box to the left of the account name. Note that you can also display the Actions menu by right-clicking on the account.
The Actions menu is grouped into four groups of options. The first group of options allows you to edit, configure, or impersonate an account. The next group of options provides functions related to specific tasks, such as managing security, setting service plans, or creating reports. The next group of options allows you to delete or rename an account. The final option on the Actions menu toggles the display of the Account Details Information Panel that is displayed at the bottom of the screen. Because you will perform most of your account management functions using the Actions menu, we’ll explain each of the options on this menu.
_____________________________________________________________________________________
The Edit Account option
_____________________________________________________________________________________
Select Edit Account to display a panel that allows you to edit general account information. Note that for all information that is displayed in the Edit Account panel, field names that are preceded by a red asterisk are required fields.
The Edit Account panel is divided into four tabbed pages. Click the Account tab to view or change the user name, brand, and security role that are assigned to the account.
For example, suppose the user for this account has left the company and another user has taken his place. This means the login credentials need to be changed for the account to make them private to the new user and the contact information for the account may need to be changed as well. To do this, first change the user name by entering a new user name in the User Name field and click OK. A message confirms that the user name was successfully changed and reminds you to change the user name in the Backup Manager on the machine to be backed up, if this account is using a service that requires the Backup Manager. It is also possible to rename the username by selecting the Rename option from Actions menu or right clicking the account and selecting Rename.
To change the password to a new, temporary password which the user will have to change the next time he or she logs in to the account, click Actions, select Password/Security, and then select Change Password on the sub-menu, click the Generate Randomly checkbox if you want to generate a random password, click the Send Email checkbox if you want the password sent in an email to the address or addresses on file in the contact information for the account, and click Submit. A message confirms that the password was changed and an email was sent, if you selected this option. Note that you may want to confirm the email address with the user before generating the email that sends out the temporary password when checking the Send Email checkbox.
If you want to change the password to a permanent password rather than a temporary password, impersonate the account by selecting Impersonate from the Actions menu and set the permanent password using the same Change Password option. This is because only the account owner can change his or her password to a permanent password. Do not forget to make any necessary changes to the contact information and notification settings from the My Account menu as well while you are impersonating the account. Then click Stop Impersonation. We will discuss impersonation in more detail shortly.
Note that if you want to change the password for your own account, you must do so through the My Account menu option on the Main Menu bar.
Finally, if this account is using a service plan that requires the Backup Manager, such as the Files for Backup service plan or the BDR for ShadowProtect service plan, enter the new user name and password in the My Account page in Backup Manager on the machine being backed up. If you fail to do so, the account will not backup any data from that point forward. The Backup Manager must have the same login credentials that exist in the Web Portal for backups to occur.
To demonstrate making the changes in the Backup Manager, in this example, because the account is using the Select Backup for Files service plan, which requires the Backup Manager, open the Backup Manager on the local machine that is being backed up, click the My Account tab, enter the new user name and password into the Account Credentials fields, and click Test Connection. Be sure to click the Test Connection button, not the Change Password button, to store the credentials in the Backup Manager. If this machine has been previously backed up, a message will ask if these changes apply to the same machine, which, in this case, they do, so make the appropriate selection. This completes what you need to do in the Backup Manager, unless you want to make changes to other configuration data for the new user, and this completes our scenario.
Getting back to the Account tab in the Edit Account panel, to change the brand to which this account is assigned, click the Brand down-arrow and select the new brand. This applies to partners who have multiple brands. Most partners only have a single brand under which they resell eFolder services, so the sub-menu would only have a single brand.
The Role field is used to change the user’s security role. For example, to change the security role from “none” that is automatically assigned to an account when it is created to “Partner Customer Service,” select the “Partner Customer Service” role from the drop-down menu in the Role field. Before assigning a new role, however, be sure you understand the privileges and restrictions that go along with that role. You do not, for example, want to assign an end-user a role that has the authority to alter or delete accounts. For more information on security roles, see the related video in this series entitled, “Choosing a security role and a service plan for an account.” Note that only a user with the Partner Senior Manager role has the ability to change roles.
You can also change an account’s status on this panel. For example, you might change the status of an account from “Enabled” to “Disabled” for a customer who has failed to make payment for your services. A disabled account suspends the service the account is using. Even though an account is disabled, the end-user can still access their previously backed up data.
Note that eFolder will continue to bill you, the partner, for any account that has been disabled, as that account continues to occupy space in the cloud from prior backups. To stop billing for an account, you must delete the account, not disable it.
Note also that disabling a parent account will not automatically disable its sub-accounts. Each sub-account must be disabled separately.
When you disable an account, you can enter a reason for doing so in the Reason field, such as “Payment is 45 days overdue.” The next time a backup is attempted, it will fail because the account has been disabled. The text you entered in the Reason field will appear in the Status Summary section of the Account Summary tab of the Account Details Panel when the account details are being displayed for that account. This message does not appear in the Backup Manager. Instead, the log in the Backup Manager and the email notification of failure that is sent out will contain the message, “Your account is disabled. Please contact customer service to have your account activated.” In other words, even though you have disabled the account, you will still need to notify your customer of their overdue status. You cannot use the text you enter in the Reason field to communicate back to the end user the reason for disabling the account.
Finally, note that there is no expiration date on a disabled account. The account will remain disabled forever until you re-enable the account. If you disable an account because a customer has failed to pay and the customer ultimately quits the service, then you must remember to delete the account so you will not continue to be billed for the data that has been previously stored in the cloud for that account.
You can also put an account into maintenance mode if you are directed to do so by the eFolder support team, which suspends all backups. For example, you should put an account in Maintenance Mode when you perform an initial USB preload on a machine to be backed up. For USB preloads, do not take an account out of maintenance mode. The eFolder Technical Support team will do this after they have finished loading the data into the cloud from the USB device. If an account is unexpectedly put into maintenance mode, you should investigate why it was placed there before you take it out of maintenance mode.
Click the Contact tab to display or edit the contact information and the time zone selection that will be used for the account. The time zone selection is used for fields that display time-stamped information, such as when the last backup occurred or when a warning occurred during a backup. Changes made to company information may affect other accounts for the same company that have the same Customer ID.
Click the Service Plan tab to display or change the service plan that the account is using. For example, to change the service plan for the account from a trial account to a regular account, click the drop-down menu in this field and select a non-trial service plan. This is how you convert a trial account to a regular account.
You can also set disk space quotas for the account. The Hard Quota field specifies the maximum amount of storage allocated to this account. This field defaults to infinity. The recommended setting for Basic and Select trial accounts is 10 GB and 150 to 500 GB for ShadowProtect trial accounts.
The User Quota field allows end-users to set their own storage limit for the account. However, very few end-users set their own quotas. This field is provided for those few users who want to control their backup costs and always stay below a certain quota, no matter what.
Note that the actual quota the system uses is the minimum of the Hard Quota and the User Quota. Of the two quotas, the more restrictive one is the one that applies.
When an account reaches within 15% of either the hard quota or the soft quota, an automated notification is sent to the email address in the Contact Information for the account. When the account reaches the actual quota, all backups cease, at which point you or your administrator will either have to raise the quota or delete data at the storage destination to make room for new data.
As a general rule, as a partner, you should only set a hard quota on an account if the customer has purchased a predetermined amount of storage from you. If you plan to bill your customer based on actual usage, and your customer wants to stays within a certain limit, it is better to encourage your customer to set a Total Disk Usage notification in the Web Portal rather than set a user quota. Doing so will allow backups to continue rather than being stopped, and the customer will be notified when they approach or exceed their chosen limit.
Note that if you set a hard quota on a parent account, then that quota represents the total amount of storage that will be allowed for the parent account plus all of its sub-accounts collectively. When that quota is reached, the parent account and all of the sub-accounts will no longer backup data.
For sub-accounts, the actual quota the system uses is the minimum of the sub-account’s hard quota, the sub-account’s user quota, and of the amount of storage space remaining under the quota for the parent account.
The Provisioned Mailboxes field applies only to accounts that have the Select Backup for Files service that are also using the optional eFolder Email Archiving add-on feature to backup Microsoft Exchange mail servers. Email Archiving is a separate product from the Backup for Files service and must be licensed separately. However, this service is no longer being offered through eFolder, so this field applies only to those legacy partners who still have the service. Details about this field will not be further discussed here. Email Archiving is still available through a third-party vendor. If you are interested in this service, please talk to your Account Manager.
[bookmark: _GoBack]Click the Notes tab to display notes that you can enter for this account. Text in the Notes visible to user field can be seen and modified by the end-user. Text in the Notes visible to staff field will not be visible to the end-user, but it will be visible to you and your internal support staff that have the required security roles. These fields are limited to 255 characters in length.
Now that we have looked at all of the functions on the Edit Account option of the Action menu option, let’s move on to the next option on the Action menu.
_____________________________________________________________________________________
The Configure and Impersonate options
_____________________________________________________________________________________
The Configure Account option is currently disabled, so this option will not be discussed.
Select Impersonate on the Actions menu to impersonate the account you have selected in the account list. Impersonating an account lets you view the Web Portal as if you had logged in using that account’s user name and password. This is done without your having to log out of your own account and login with the other account’s login credentials. Impersonating an account is useful, for example, when you want to see what functions are available to a user in the Web Portal, such as verifying that they cannot change or delete accounts after assigning them a new security role. Impersonation is more frequently used to access the options in the My Account menu of the Web Portal to configure notifications, mailing lists, and contact information and to set the password for that account—things you cannot otherwise access from your partner account.
When you select the Impersonate option on the Action menu, a message is displayed on a yellow background at the top of the account list that reminds you that you are impersonating the account. You now have the same privileges and restrictions in the Web Portal as the user you are impersonating. You can navigate around the Web Portal and perform tasks as if you were that user. When you have finished and are ready to stop the impersonation, click Stop Impersonating on the far right of the message that is displayed in Yellow. You are returned to the Account Center where you left off. Any changes you made while impersonating the account remain intact after you stop the impersonation.
Before you can impersonate an account, you must have a security role that allows you to do so. If you logged in to the Web Portal using your partner account, you have the authority to impersonate any of the accounts that are displayed in your account list. As a general rule, you can impersonate any account that has your same security role or a lower-level security role.
_____________________________________________________________________________________
The Password/Security option
_____________________________________________________________________________________
Getting back to the Actions menu, select Password/Security to display a submenu containing options for resetting or changing a password, resetting the pass phrase lock, and changing the security role assigned to the account.
Select Reset Password on the submenu to generate a temporary, system-generated password that can be given over the telephone to the end-user and/or emailed to the address or addresses currently stored in the contact information for the account.
Select Change Password to change the password to one you create. Because you are a partner, you do not need to know the old password to change the password to a new one. You also have the option to generate a random password. You can optionally have the password emailed to the address or addresses currently stored in the contact information for the account. Note that this is a temporary password that must be changed to a permanent password the first time that the account is used.
Regarding passwords, consider the following scenario. Suppose you receive a call from a customer or end-user saying they have forgotten their password. If you have a way to verify the identity of the caller, then you could create a new password using the Change Password option, give the user the new password over the telephone, and wait for that user to verify that they can log in to the Web Portal with the new password. The user will be prompted to change the password after logging in. Do not forget that if the account is using the Backup Manager, the password field on the My Account page must also be updated.
If you cannot verify the identity of the caller who is requesting a new password or are unsure, then select Reset Password to generate a temporary password and click Yes in the Password reset dialog box to have the password emailed to the address on file in the contact information for the account. For any temporary password that is set using the Reset or Change password options, the user will be prompted to enter a new, permanent password the next time they log in. Note that you can enter the email address of your own help desk rather than the end-user’s email address if you want.
Select Reset Pass Phrase Lock on the Password/Security submenu to allow a new pass phrase to be created in the Backup Manager. A pass phrase is different than your account password. Your account pass phrase is used to encrypt the data that is stored in the cloud. Your account password is used to login to your account in the Backup Manager and in the Web Portal so that you can manage your account.
Although the option is presented here to change your pass phrase to accommodate special and unusual circumstances, we strongly recommend against doing so. Here’s why. The data that is stored in the cloud is unreadable to anyone, including our own staff, and cannot be restored to a human readable format until the exact pass phrase is provided and the data is unencrypted using that pass phrase. The pass phrase that was in place at the time the data was encrypted is the one that must be used in the future to unencrypt the data. The two are inextricably bound together as far as restoring the data is concerned. That is why you would seldom, if ever, change your pass phrase for a given account. If you do change your pass phrase, then you would either have to delete all of the data in that account and start over, or you would have to remember the old passphrase to unencrypt data from previous backups and the new pass phrase to unencrypt data from future backups.
Select Set Role on the Password/Security submenu to change the security role for the account. Suppose you have just finished creating a new account for one of your support staff who will be handling support calls for your rebranded backup services. After creating the account, select this option and assign the account an appropriate role, such as Partner Customer Service. By default, when an account is created, it is not given a security role. “No role” means the account will have the greatest restrictions as far as creating, viewing, and managing accounts is concerned. Note that partners are given a security role that allows them unrestricted access to all of their accounts and partner management functions. For more information on security roles, see the related video in this series entitled, Choosing a security role and a service plan for an account.
_____________________________________________________________________________________
The Service Plan option
_____________________________________________________________________________________
Select the Service Plan option on the Actions menu to set and manage the service plan associated with this account. Changing the service plan for an account has already been discussed in this video.
Select Set Expiration Date on the Service Plan submenu to set an expiration date on trial accounts. You cannot set an expiration date for a billable service plan.
The next three options, Set User Quota, Set Quota, and Set Number of Mailboxes, were already explained when we discussed the Edit Account option, where you can also perform these functions.
Select View License Keys to display the list of license keys associated with the account. This applies to ShadowProtect, Acronis, and GRE/Kroll licenses. You can search the list that is displayed and see the information for each license key, such as who the owner is (which is usually the user account); the type of license key, such as MSP ShadowProtect Key and ShadowProtect Server (Legacy); the license key; the number of licenses (or units) provisioned; the number of current activations that you are being billed for; when the key was first provisioned; and when the key was first activated.
Select Provision License Keys to provision license keys for an account. Enter the number of license keys you want to provision, select the type of license key, and click Submit. The new license will be immediately displayed on the screen. You can also see the new license in the View License Keys option. You will only be given the option to provision licenses that you are authorized to resell. ShadowProtect and Acronis require signed agreements. Contact your Account Manager to get these agreements in place.
_____________________________________________________________________________________
The Account Attributes option
_____________________________________________________________________________________
Use the next item on the Actions menu, Account Attributes, to change the brand associated with the account, edit the email address for the account, change the account descriptions, convert a parent account to a sub-account, convert a sub-account to a parent account, or change a sub-account to a different parent account.
Select Set Brand on the Account Attributes submenu to change the brand associated with the account. When you create a new account for a new customer, you select the brand that you want the account to have as part of the process of creating the new account. When you create an account for an existing customer, the brand assigned to the new account will be the same brand as the existing customer. Use the Set Brand option if you need to change the brand that is associated with an account after it has been created.
Choose Set Email Address on the Account Attributes submenu to change the email address or addresses associated with the account. As a partner, you must decide what information you want to enter in the contact information fields for an account, including the email address field. For example, when you create a new account, you can put in your own email address, the customer’s email address, or a group of email addresses that are separated with a semi-colon. Whatever you decide, you should be consistent across your accounts.
Note that the email address that you enter in the Email Address field might not be the email address of the person in the First and Last name fields for the account. In fact, many partners prefer to enter their own email address in the Email Address field for their accounts so that they will receive notifications about the account instead of their customers.
The Set Internal Description and Set Description options perform the same functions as the Notes visible to staff and the Notes visible to user fields that were explained previously in this video.
Select the Convert to Sub-Account option in the Account Attributes submenu to change a parent account to a sub-account. In the dialog box that follows, select the new parent account from the list of parent accounts and click Choose. The account is converted into a sub-account under the parent that you selected. It is important to note that sub-accounts always inherit the service plan of the parent account. Because of this, when converting a parent account to a sub-account, if the two accounts have different service plans, the new sub-account is always assigned the service plan of the parent account. Finally, note that you cannot make your original partner account—the one given you when you became an eFolder partner—a sub-account of another account.
If the account you are working on is already a sub-account, you are presented with two options: Convert to Parent Account and Change Parent Account. The Convert to Parent Account will change the account to a parent account and will maintain the current service plan. If you want a different Service Plan, you will need to select the desired service plan. The Change Parent Account option moves the sub-account to the parent account that you selected and assigns it the service plan associated with the new parent account.
_____________________________________________________________________________________
The Account Status, Reports, and More Actions options
_____________________________________________________________________________________
Select Account Status on the Actions menu to put an account into maintenance mode or to disable an account—functions we have already discussed in this video.
Select Reports on the Actions menu to generate certain types of reports for the selected account, including the Online Backup Session Report, the Audit Log, and the Event Log. Reports are discussed in detail in the related video in this series entitled, Viewing Reports in the Web Portal.
Select More Actions on the Actions menu and Send Welcome Email on the submenu to send a welcome email to the email address or addresses associated with this account. A message box shows you where the email was sent. The welcome email contains login information for the account and links on how to get started.
_____________________________________________________________________________________
The Delete and Rename options
_____________________________________________________________________________________
Select Delete on the Actions menu to delete an account. Deleting an account does two things: it stops future backups for the account, and it stops billing for the account. However, the data for the account remains in the cloud for 14 days. On day 15, the data is purged, but the account itself is never removed from the account list and remains there as a deleted account to provide an audit trail and history for the account.
To delete an account, select Delete and click Yes in the confirmation box. A message confirms that the account was deleted. If you have checked the Show Deleted checkbox in the Options menu, the account appears on a dark gray background with a trash can icon in the second column. If you did not check this checkbox, the deleted account is hidden and no longer appears in the account list. Note that deleting a parent account will also delete all of its subaccounts.
To reactivate a deleted account, display and select the deleted account in the account list, select Reactivate on the Actions menu, and click Yes. A message confirms that the account has been reactivated. Note that to reactivate a child account, the parent account must be reactivated first. Alternatively, the deleted child account can be converted to a parent account before it is reactivated.
The values stored in the various fields of a restored account are a "snap-shot" of the account as it was when the account was deleted, so this information could very well be outdated. However, after the next backup has been completed, all subsequent fields that can be will be updated with current information. To force an update of this information sooner, click the Test Connection button on the My Account panel in the Backup Manager on the machine that is being backed up. After reactivating an account, be sure to update any account contact information that might have changed.
To reactivate an account after 14 days, follow this same procedure and then re-seed it with a new image, since the original data for the account will no longer be available in the cloud. Alternately, create a new account for the user instead of restoring the old account, but this will require that you enter all of the account information again.
Select Rename on the Actions menu to change the user name for the account. If you change the user name for the account, remember to change the user name in the Backup Manager configuration as well so that backups will continue uninterrupted.
Select Show/Hide Details on the Actions menu to show or hide the Account Details Information Panel at the bottom of the screen. This area displays detailed information for the currently selected account in the account list. The information displayed in this panel will be explained shortly.
This concludes our review of the functions that are available on the Actions menu option.
_____________________________________________________________________________________
The Options and View menu bar options
_____________________________________________________________________________________
The next option on the Account Center menu bar is labeled Options.
Click Options to display options for showing or hiding deleted accounts, controlling how colors are used, setting the size of the text that is displayed, and choosing the overall color theme that you prefer for displaying accounts.
Select Show Deleted in the Options menu to show or hide deleted accounts. Deleted accounts are displayed with a dark gray background, and they have a trash can icon to the left of the account name. Use the navigation controls at the bottom of the screen to page through your list of accounts if necessary.
Select Colors in the Options menu to choose how you want to use colored backgrounds in the Account Center. You can use color to indicate account status or to show accounts that are in alert status, or you can choose not to use colored backgrounds at all. For example, selecting Alerts Only will cause accounts that have a warning or error status to display with a yellow and red background, respectively, in the list of accounts.
Select Text Size in the Options menu to choose the size of the text you want to use for the account list. If you are straining to read the entries in the list, choose a larger text size.
Select Theme in the Options menus to choose whether you want to use a blue or gray color scheme in the Account Center. For example, selecting Gray displays everything in the Account Center in shades of gray except for the account list itself, which follows the color coding selection you made on the Colors option.
The next option on the Account Center menu bar is View.
Click the drop-down arrow in the View: option to choose which related group of fields you want to display in the account list. There are four groups of related fields that you can display in the list: account details, contact information, resource usage, and account status. Clicking the View: button repeatedly toggles across these four options. Because there are over 30 fields of information that are associated with each account, the View: button is provided to make it easy to see related fields of information without having to scroll left or right across the screen.
You can also further control which columns of information you want displayed for any of the four View: options by moving your cursor over any of the field names at the top of the list, clicking the drop-down button, selecting Columns, and putting a check mark next to the fields you want to display in this view. Your selections will remain in effect until you exit and re-enter the Account Center, at which time the default fields are displayed in each of the four View: options.
_____________________________________________________________________________________
The Account Details menu bar button
_____________________________________________________________________________________
The next button on the Account Center menu bar is the Show or hide account details information panel button. Do not confuse this icon with the View: Account Details menu option in the Account Center menu bar. They are not the same and do different things.
Click the Show or hide account details information panel button to display or hide the Account Details Information panel, which provides additional detailed information for the account that is currently selected. You can also double click on any account to show or hide the Account Details Information Panel, or right click on the account and select Show/Hide Details.
The Account Details Information panel is divided into four tabs: account summary, service plan, contact information, and status details.
The Account Summary tab of the Account Details Information panel has two sections: the Status section, and the Account Information section. The Status section displays a computer icon on the left that indicates whether the computer is a server or a desktop. The first line of the Status Summary section displays the user name for the account in bold text, the service plan assigned to the account in square brackets, and the computer name in bold text in all caps. The next line (or lines) displays, for each backup destination (such as cloud, local server, or local storage device), the amount of data that is being stored at that destination. For the Online backup accounts, the quota is also shown. For accounts that have backed up at least one time, this section also displays icons you can click on to display various reports and logs. Move your cursor over these icons to display tooltips that further explain the icons. The last line in this section displays the current status icon and status messages for the account.
For AppAssure CORE accounts, click the View AppAssure CORE Details icon to display detailed information about your AppAssure CORE account. This information is organized into three tabbed pages. Click the Home tab to display an overview of the status of your protected machines, replicated machines, and repositories.
Click the Events tab to display detailed information about the status of any jobs, including backup, replication, or virtual standby jobs, and to view the progress of active jobs. The Tasks list displays the high-level status of individual tasks that have run, such as backup snapshots, replication jobs, seed consumes, and so forth. The Alerts list displays conditions that the user should be aware of. The Events list displays more detailed status information.
Click the Notifications tab to display a history of the health of the AppAssure core over time. For example, this list displays the exact time that error alerts and error resolution alerts were sent and which notification rules were triggered. Note that you can search this list using the Quick Search and Advanced Search fields at the top.
Back on the Account Details panel, click the Backup Session Report icon to display a report of all of the backup sessions performed or attempted on the account. The Backup Sessions Report has a tabular format and uses functionality that is similar to that in the Account List (Detailed View). You can cursor over the column headers to display tooltips that further explain the information displayed in each column. This report is explained in detail in the related video in this series entitled, Viewing Reports in the Web Portal.
Click the View Online Backup Summary Report icon to display a graphical view of the backup history for the account. Click the next icon to download this same report.
Click the View Online Backup Log icon to display the most recent Backup Log which has been pushed out to the Web Portal by the Backup Manager. Click the next icon to download this same report.
Click the View Backup Settings icon to display the Backup Manager configuration settings as they existed at the time of the last backup.
And finally, if you bought a BDR from eFolder, click the View Hardware Status icon to display the status of over 30 different hardware functions of the BDR, such as the temperature of the processor, temperature of the memory chips, fan speed, and so forth. Note that these icons display information that you would otherwise have to gather by physically logging in to the remote machines.
The next section of the Account Summary tab, labeled Account Information, displays information such as whether the account is a parent account or a sub-account, whether the last backup session was able to login to the cloud, whether the account is in maintenance mode, internal and external descriptions of the account, when the account was created, when it was deleted, if it has been deleted, and the server ID that the account is assigned to in the cloud.
The next tab on the Account Details panel is the Service Plan tab. This tab displays the service plan that has been assigned to the account, whether the account can view the compressed file size, and the number of licenses keys assigned to the account with a link to view the licenses keys.
The Contact Information tab displays the contact information on file for the account, including name, address, phone, and email address information.
The Status Details tab displays, for each backup destination, the storage space usage, the status of the last backup, when the last backup occurred, when the last good backup occurred, and any status details information. For AppAssure CORE accounts, additional information is displayed, including the operational status and details for the AppAssure CORE and for the hardware appliance.
This concludes our review of the Account Details panel.
_____________________________________________________________________________________
The list of accounts section
_____________________________________________________________________________________
The main information display in the Account Center is the list of accounts. Which accounts are displayed is controlled by several functions, including the search and filter box and the Show Deleted option on the Options menu. For long lists of accounts, how many accounts are displayed at a time and which page is displayed are determined by the controls at the bottom of the list. Which columns or fields are displayed is controlled by the View: button on the menu bar and by moving your cursor over any of the field names at the top of the list, clicking the drop-down button, selecting Columns, and putting a check mark next to the fields you want displayed in this view.
To perform an action on an account, first select the account by clicking on the account or clicking the checkbox in the first column next to the account. Then do one of the following three actions to display the Actions menu: click Actions in the menu bar, double-click on the account, or right click on the account. Then select the action you want to perform from the options and submenus that are displayed that we previously discussed. For example, to disable an account for non-payment, select the account in the list, select Account Status and then Disable.
Note that you can select multiple accounts at one time by clicking multiple checkboxes in the first column or by holding down the control key and left-clicking on all of the accounts you want to select. Then select an action you want to perform from the Actions menu. For most actions you can take, the action you select will apply to all of the accounts you have selected.
To select or de-select all of the accounts that are in the currently displayed list, click the checkbox at the top of the column. Note that accounts that are not currently displayed, such as those on page 2 or 3, will not be selected.
The account list also displays the current status of each account by displaying status icons in the second column. Move your mouse cursor over these icons to see a description of the account’s status. The status icons are color-coded to give you a quick visual indication of the status of your accounts. A green status means the account is “good,” meaning no warnings or errors have been detected. A yellow status means “warning” and applies to accounts that require human attention and are having minor issues. A red status means “error” and applies to accounts that require human attention and are having important issues that need to be resolved. A gray status means the account never has had a remote backup.
The status icons may also appear in other resource-usage fields in the account list to indicate the status of a particular service. For example, these icons might indicate that remote backups are good, but local backups are failing. You can use these color-coded visual indicators to quickly see which services across your accounts are having trouble or are failing and which are okay.
Use the Search Box in the menu bar to search for and display only accounts that meet the criteria or filters you specify. For example, you can enter a portion of the name in the search field to filter the list. You can also use filters to filter the list of accounts on any of the displayed fields. To do so, move your cursor over the field name at the top of the list, click the drop-down arrow to display the drop-down menu, select Filters, and enter in your filter criteria. For example, to display only Select accounts, click the Service Plan drop-down arrow, select Filters, and enter “Select” in the Contains field.
You can also sort the list on any field by using the same drop-down menu for that field and selecting Sort Ascending or Sort Descending. For example, to sort by company name, display the pull-down menu for the Company field and select Sort Ascending. The list is sorted alphabetically by company name.
We will now review the fields of information that are displayed for each of the four views that are displayed by clicking the View: button on the menu bar, starting with the View: Account Details display.
_____________________________________________________________________________________
The View: Account Details display
_____________________________________________________________________________________
The third column in the View: Account Details display, labeled ID, is an internal-to-the-system account identification number that is automatically generated by the software when a new account is created. No two accounts are given the same ID. The ID is a reference number that is used internally by the system, for example, to identify the parent account for an account.
The next column, labeled Cust. ID, is the customer ID field. Whenever you create a new customer account in the Web Portal, that account is given a unique customer ID by the system. Every account is assigned to a customer.
Note that accounts with the same customer ID create a single billing entity. Any billing reports you create will consolidate storage space usage across all of the accounts assigned to that customer. This makes it easy for you to bill that customer.
The next column, labeled Brand, is the brand identifier to which the account has been assigned. Most partners only have one brand, but some partners need more than one brand to market their services to different vertical markets. This field displays the brand to which the account has been assigned.
The next column, labeled “company,” displays the name of the customer’s company. This is an optional field that is entered when the account is created.
The next column, shown with an icon of a person at the top of the column, is used to indicate the security role assigned to the account. The default security role is assigned to new users and does not show an icon. If you hover over the icon, it will display the currently assigned role.
The next column in the Account List, labeled User Name, displays the user name. The user name is used to log in to the Web Portal and must also be entered into the Backup Manager for accounts that use the Backup Manager. Note that for sub-accounts, the user name is displayed indented and with a sub-account icon directly under the parent account. This username must be unique throughout all of the eFolder accounts.
The next column, labeled “Service Plan,” displays the eFolder service plan assigned to this account. You can change the service plan for parent accounts by clicking Actions on the menu bar, selecting Service Plan, selecting Set Service Plan on the sub-menu, and selecting a new service plan, as was previously discussed.
Note that changing the service plan for a parent account automatically changes the service plans for all of the sub-accounts under that parent account, since sub-accounts always inherit the service plan of their parent accounts. For example, changing this parent account from Basic to Select automatically changes all of the sub-accounts under this parent to the Select service plan. Because of this, be very careful when changing the service plans of parent accounts.
Also note that if you try to change the service plan of a sub-account, a message will display informing you that you cannot do so because this sub-account automatically inherits the service plan of its parent account. To change the service plan of a sub-account, either make it a sub-account under a different parent account for the same customer that has the desired service plan, or if no such parent exists, then create a new parent account with the desired service plan or convert the sub-account to a parent account.
To change the parent account for a sub-account, click Actions, select Account Attributes, and select Change Parent Account on the submenu, select the new parent account, and click Choose. The account will then inherit the service plan of its new parent account.
On the other hand, to convert a sub-account to a parent account, click Actions, select Account Attributes, select Convert to Parent Account on the sub-menu, and click Yes in the confirmation box. Note that after you have converted a sub-account to a parent account, you can then change the service plan for the account.
The next column, labeled “Expires,” shows when the trial account will expire. This field applies only to trial accounts, as non-trial accounts do not expire.
The next column, labeled “Quota,” displays the storage quota that has been assigned to the account, if one has been assigned. Quotas were discussed previously in this video.
The next column, shown with a globe icon at the top, displays how much storage space the account is using in the cloud as well a current status icon, if the account has backed up data at least once to the cloud.
The next column, shown with a disk drive icon at the top, displays how much storage space the account is using on the local disk, for accounts that are backing up data to a local disk.
The next column, shown with a network server at the top, displays how much storage space the account is using on the local server, for accounts that are backing up data to a local server.
The next column, shown with an envelope icon at the top, displays email archiving details, for Select Backup for Files accounts that are also using the optional eFolder Email Archiving add-on service to backup Microsoft Exchange mail servers. Email Archiving is a separate product from the Backup for Files service and must be licensed separately. However, this service is no longer being offered through eFolder, so this field applies only to those legacy partners who still have the service. Details about this field will not be further discussed here. Email Archiving is still available through a third-party vendor. If you are interested in this service, please talk to your Account Manager.
This completes our discussion of all of the fields that are displayed in the View: Account Details display.
_____________________________________________________________________________________
The View: Contact Information display
_____________________________________________________________________________________
Now let’s discuss the fields that are displayed when you click the View: Contact Information button.
The Status Information, ID, Account Role, User Name, and Company columns were discussed in the previous section.
The columns labeled “First Name,” “Last Name,” and “Phone” display the name of the contact for the account and the contact’s phone number. This information is useful, for example, if you get a notification that an account has not backed up for several days and you want to contact the user to find out why. For example, the user could have been out on vacation for a week and no new data was created that needed to be backed up.
The next column, labeled “Email,” displays the email address or email addresses associated with the account. Note that this email address might not be the email address of the person in the Name field. In fact, many partners prefer to enter their own email address in the Email Address field so that they will receive notifications about the account instead of the customer.
The next two “Address” columns usually displays the street number portion of the address information for the customer to whom this account is assigned, although some partners put their company address in this field.
The next four columns, City, State, Zip, and Country, display the rest of the address information for the customer to whom this account is assigned.
Regarding the contact information for an account—it is important to note that only the person who created the account and those who can impersonate the account in the Web Portal can see the contact information for an account. The customer or end-user can view and edit the detailed contact information by selecting Contact Information under My Account on the menu. As a partner, you must decide what information you want to enter into these fields when you create new accounts. For example, do you want to put in your own email address or the customer’s email address in the Email Address field or a group of email addresses that are separated with a semi-colon? Whatever you decide, you should be consistent across your accounts.
This completes our discussion of all of the fields that are displayed in the View: Contact Information display.
_____________________________________________________________________________________
The View: Resource Usage display
_____________________________________________________________________________________
Now let’s discuss the fields that are displayed when you click the View: Resource Usage button.
Several of the columns in this display have already been discussed in the previous two sections and will not be repeated here.
The columns labeled “Disk GB” with their corresponding icons display the total disk space used by an account at each backup destination—the cloud, the local disk, and the local server—if multiple destinations are being used.
The columns labeled “All Disk GB” with their corresponding icons display the disk space used by this account plus all of its sub-accounts—again, by destination—the cloud, the local disk, and the local server—if multiple destinations are being used.
The columns labeled “Last Backup” with their corresponding icons display the date and time of the last attempted backup, either successful or failed, and are shown with a green check box or red x, that was performed on the account—again, by destination, such as the cloud, the local disk, and the local server, if multiple destinations are being used.
This completes our discussion of all of the fields that are displayed in the View: Resource Usage display.
_____________________________________________________________________________________
The View: Account Status display
_____________________________________________________________________________________
Now let’s discuss the fields that are displayed when you click the View: Account Status button.
Several of the columns in this display have already been discussed in the previous three sections and will not be repeated here.
The column labeled “Customer” is the same as the Company field that we have previously discussed.
The column labeled “OS” for “operating system” displays the operating system that is on the machine being backed up.
The column labeled “Version” displays the version of the Backup Manager, not the operating system, that is on the machine being backed up.
The column labeled “Status Information” displays detailed status information the system has generated for the account. This information further explains the status of the account. Additional details can be accessed by selecting Dash Panel under Reports on the menu bar and selecting Status Details on the far right.
This completes our discussion of all of the fields that are displayed in the View: Account Status display.
Congratulations! You have now reviewed all of the fields that can be displayed in the Account Center.
Thank you for watching this video on how to use the Account Center in the Web Portal.
Regarding your next step in your training: At the beginning of this video, we explained that the Web Portal provides two separate interfaces for performing account management functions: the Account Center, and the Account List. This video has explained how to use the Account Center. If you would also like to learn how to use the Account List interface that is designed for power users, please continue with the next video in this series entitled, Using the Account List in the Web Portal. If you will only be using the menu-driven Account Center interface, then continue with the video in this same series entitled, Viewing Reports in the Web Portal.
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